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Support

Please visit the HP OpenView web site at:

http://www.managementsoftware.hp.com/ 

This site provides contact information and details about the products, services, and support that HP 
OpenView offers. To reach the Support site, click Support. The Support site provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valuable support customer, 
you can benefit by using the support site to:

• Search for documents of interest

• Submit and track progress on support cases

• Manage a support contract

• Look up HP support contacts

• Review information about available services

• Join online discussions with other software customers

• Research and register for software training

Most of the support areas require you to register as an HP Passport user and log in. You may also require a 
support contract.

To find more information about access levels, go to the following URL:

http://support.openview.hp.com/access_level.jsp 

To register for an HP Passport ID, go to:

https://passport.hp.com/hpp2/newuser.do
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Chapter 1
Overview

This chapter covers the following topics:

• NNM Events and NNM Availability

• Folders and Reports

• Ways to Customize Reports

• Sources for Additional Information

NNM Events and NNM Availability

The NNM Event and Availability Report Pack provides trending analysis for event and 
downtime data collected from NNM stations. NNM uses the following attributes to define an 
event:

• Category

• Severity

• Device

• Device Type

• Vendor 

• Customer

The NNM Event and Availability Report Pack allows you to see event and downtime data 
aggregated in helpful ways. You can see whether availability for a particular device is 
improving or worsening; and you can see whether availability for a particular customer is 
improving or worsening. You can look at the distribution of alarms across alarm categories, 
and see the trend line for each alarm category; and you can look at the distribution of severity 
levels, and see the trend line for each severity level. In addition, you can find out which 
devices are responsible for the majority of alarms in each alarm category.

Folders and Reports

When you install NNM Event and Availability, OVPI creates the NNM_Report directory. This 
directory has two child directories: 
7



Folders and Reports
• Availability

• Event

The Availability directory contains:

• Detailed Availability

• Availability Forecast by Customer

• Availability Forecast by Vendor

• Availability SLA 

The Event directory contains multiple subdirectories:

• General

• Category

• Severity

• Consolidated 

General

The General directory contains:

• Event Summary by Customer

• Event Summary by Device Type

• Event Summary by NNM Station

• Event Summary by Vendor

• Event Summary by Customer

• Executive Summary by Vendor

• Forecast by Category

Category

The Category directory contains:

• NNM Event Summary by Category and Device 

• NNM Event Summary by Category and Device Type

• NNM Event Summary by Category and Severity

• NNM Event Summary by Category and Vendor

Severity

The Severity directory contains: 

• NNM Events by Severity and Category

• NNM Event Summary by Severity and Device 

• NNM Event Summary by  Severity and Device Type

• NNM Event Summary by  Severity and Vendor
8



Chapter 1
Consolidated

The Consolidated directory contains:

• NNM Events by Category 

• NNM Events by Severity

• Executive Summary by Category 

• Executive Summary by Severity 

• Hot Spot Report

Ways to Customize Reports

You can customize reports by applying group filters, by editing parameters (same as applying 
constraints), by editing tables and graphs, and by importing customer names. Service 
providers, or any organization that wants to share reports with customers, require group 
filters in order to produce customer-specific reports. If you edit a table, graph, or parameter, 
you are making a temporary change to a report. Any user can make these edits.

Group Filters

If you want to share reports with your customers, you must configure OVPI to produce 
customer-specific reports. Here is an overview of the steps involved:

• Use Common Property Tables to import customer names and device locations

• Create a group account for all the users affiliated with each customer

• Create a group filter for each group account

For more information about creating filters for group accounts, refer to the Performance 
Insight 5.0 Administration Guide. 

Editing Parameters

Editing a parameter applies a constraint to the reports. The constraint eliminates data you 
are not interested in seeing. The NNM Event and Availability Report Pack supports the 
following parameters: 

• Category

• Category ID

• Customer

• Customer ID

• Device

• Device Type

• NNM Station
9



Sources for Additional Information
• Severity

• Severity ID

• Vendor

If you are using Report Viewer, follow these steps to edit a parameter:

1 Select Edit  Parameter Values from the menu bar.

2 When the Modify Parameter Values window appears, click the Current Value field.

3 Enter a new value.

4 Click OK.

If you are using the Web Access Server, follow these steps:

1 Click the Edit icon at the bottom right-hand corner of the report.

2 When the Edit Parameters window opens, type the constraint in the appropriate field.

3 Click Submit.

Sources for Additional Information

The demo package for the NNM Event and Availability Report Pack contains a sample of every 
report in the package. If you have access to the demo package and you want to see what fully 
populated reports look like, install the demo package. For information regarding the latest 
enhancements to this package, and any known issues affecting this package, refer to the NNM 
Event and Availability Report Pack 1.0 Release Statement. You may also be interested in the 
following documents: 

• Common Property Tables 3.5 User Guide

• Reporting and Data Analysis with Network Node Manager

• Managing Your Network with HP OpenView Network Node Manager

Manuals for the core product, OVPI, and manuals for the reporting solutions that run on 
OVPI can be downloaded from the following site:

http://www.managementsofteware.hp.com/

Select Support > Product Manuals to open the Product Manual Search page. Manuals for OVPI are 
listed under Performance Insight. Manuals for report packs, datapipes, NNM SPIs, and NNM 
correlators are listed under Reporting and Network Solutions. 

The manuals listed under Reporting and Network Solutions indicate the month and year of 
publication. If a user guide is revised, the date of publication will change even if the software 
version number does not change. Since we post revised user guides on a regular basis, you 
should search this site for updates before using an older manual that may be outdated.
10



Chapter 2
Package Installation

This chapter covers the following topics: 

• Integrating NNM and OVPI

• Installing NNM Event and Availability

• Accessing Deployed Reports

• Package Removal

Integrating NNM and OVPI

NNM Event and Availability Report Pack cannot function unless your NNM server is 
integrated with your OVPI server. If server integration has not taken place yet, do it now. You 
can integrate NNM and OVPI by installing the NNM/Performance Insight Integration 
Module. This module includes components for your NNM server and components for your 
OVPI server. For details, refer to the NNM/Performance Insight Integration Module 2.0 User 
Guide.

If your operating systems is Windows, installing the Integration Module installs a Windows 
service called ICO_RNS that moves event data from NNM to OVPI. Although the installation 
process creates the service and sets its start status to automatic, it does not actually start the 
service. You must start the service manually the first time you run it. Later, whenever the 
machine is restarted, ICO_RNS will start automatically.

Prerequisites Related to OVPI

Following is a list of software that must be running on your OVPI server before installing the 
NNM Event and Availability Report Pack:

• OVPI 5.0 installed on you OVPI server

• Any available OVPI 5.0 service pack installed on your OVPI server

• Common Property Tables 3.0 or higher installed on your OVPI server

If your operating system is UNIX, no services need to be started manually the 
first time.
11



Installing NNM Event and Availability
Installing NNM Event and Availability

Perform the following tasks to install the report pack: 

• Task 1: Stop OVPI Time and extract report packs from the RNS 7.0 CD

• Task 2: If necessary, upgrade Common Property Tables

• Task 3: Install the NNM Event and Availability Report Pack

Task 1: Stop OVPI Timer and extract OVPI packages from the RNS 7.0 CD

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Control Panel  > Administrative Tools > Services

UNIX: As root, do one of the following:

HP-UX: sh /sbin/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the RNS 7.0 CD. Do one of the following:

• On Windows, run the setup.bat command if auto run is disabled. If outrun is 
enabled, a Main Menu appears. 

• On UNIX, mount the CD manually if the CD does not mount automatically, then run 
the setup command.

4 Type 1 to select OVPI report packs in the choice field and press Enter. The install script 
displays a percentage complete bar. When extraction is complete, the install script starts 
Package Manager. The Package Manager Welcome window opens.

Task 2: Upgrade Common Property Tables 

If you are running an older version of Common Property Tables, upgrade to Common Property 
Tables 3.0 or higher. Installing the upgrade package is no different from installing other 
upgrade packages; however, you cannot install an upgrade for Common Property Tables and 
other packages at the same time. Install the upgrade package for Common Property Tables 
and only the upgrade package for Common Property Tables. When Package Manager 
indicates that the installation is complete, click Done to return to the Management Console. 

Task 3: Installing NNM Event and Availability Report Pack 1.0

1 Start Package Manager. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.

If you navigate to the Packages directory on your system, you will 
see the following directories under the parent directory for the 
report pack:
• NNM_Event.ap
• NNM_Event_Demo.ap
Installing the demo package is optional. You may install the demo 
package by itself, or you may install the demo package along with 
the report pack.
12



Chapter 2
3 Click Install. Approve the default installation directory or use the browse feature to select 
a different directory, if necessary. 

4 Click Next. The Report Deployment window opens. Accept the default settings for Deploy 
Reports; also accept the defaults for application server name and port in the same window. 

5 Enter your username and password for the OVPI Application Server. 

6 Click Next. The Package Selection window opens. 

7 Select the check box next to the following package names:

CommonPropertyTables 3.5 

NNM_Event 1.0 

NNM_Event_Demo 1.0 

8 Click Next. The Type Discovery window opens. 

9 To run Type Discovery immediately after package installation, unselect Type Discovery 
and click Next. The Selection Summary window opens.

10 Click Install. The Installation Progress window opens and the install process begins. When 
the install process is complete, an installation complete message appears. 

11 Click Done. 

12 Restart OVPI Timer.

Accessing Deployed Reports

When you installed the NetFlow Interface package, you enabled the Deploy Reports option. As 
a result, the reports in this package (as well as any forms that come with the package) were 
deployed to the OVPI Application Server. Once reports reside on the OVPI Application Server, 
you have two ways to view them:

• OVPI clients

• Web browser

If the client components are installed on the user’s system, the user has access to Report 
Viewer, Report Builder, and the Management Console. If the client components are not 
installed on the user’s system, using a web browser to view reports is the only way the user 
can view reports.

For more information about the client components, refer to the Performance Insight 
Installation Guide. For more information about the Management Console, including how to 
use the Object/Property Management view to launch reports specific to a selected object, refer 
to the Performance Insight Administration Guide.

Package Removal 

Follow these steps to uninstall NNM Event and Availability:

1 Log in to the system. On UNIX systems, log in as trendadm.

2 Stop OVPI Timer and wait for processes to terminate.
13



Package Removal
3 Start Package Manager. The Package Manager welcome window opens.

4 Click Next. The Package Location window opens.

5 Click the Uninstall radio button.

6 Click Next. The Report Undeployment window opens.

7 If NNM Event and Availability reports were deployed from this server, accept the defaults 
for Undeploy Reports, Application Server Name, and Port. Otherwise, clear the check box 
and skip to step 9.

8 Type your username and password for the OVPI Application Server.

9 Click Next. The Package Selection window opens.

10 Click the check box next to the following packages:

NNM_Event 1.0 

NNM_Event_Demo 1.0  

11 Click OK.

12 Click Next. The Selection Summary window opens. 

13 Click Uninstall. The Progress window opens and the removal process begins. When the 
uninstall process is complete, a package removal complete message appears. 

14 Click Done to return to the Management Console.

15 Restart OVPI Timer.
14



Chapter 3
Distributed Systems

If you intend to run the NNM Event and Availability Report Pack in a distributed environment 
across multiple servers, you must configure the central server and each satellite server. This 
chapter covers the following topics:

• Configuring the central server

• Configuring a satellite server

• Synchronizing system clocks

Configuring the Central Server

To configure the central server, perform the following tasks:

• Task 1: Set up connections with satellite server databases

• Task 2: Configure trendcopy pull commands and modify the entry in trendtimer.sched.

Task 1: Set up connections with satellite server databases

1 Start the Management Console.

2 Click the Systems icon on the lower left. The System/Network Administration pane opens.

3 Right-click the Databases folder. When prompted, select Add OVPI Database. The Add 
Database Wizard opens. 

4 Click Next.

5 Type the hostname and port number for the database you want to add; click Next.

6 Review the Summary. Repeat Steps 4 and 5 for each additional database.

7 Click Finish when you are done. 

Task 2: Configure trendcopy pull commands and modify the entry in trendtimer.sched

1 Open the following files:

$DPIPE_HOME/scripts/hourly_NNM_Event.pro

$DPIPE_HOME/scripts/hourly_NNM_Avail.pro

2 Modify the trendcopy commands so that each command includes the correct server name 
for each satellite server.
15



Configuring a Satellite Server
3 If necessary, add more commands.

4 Optional. If the installation requires rate data to be available on the central server, 
change SH_NNM_Event, SH_NNM_Avail in copy commands to RNNM_Event, 
RNNM_Avail. 

5 The NNM_Event.pro calls the hourly process file to collect both Event and Availability 
summarizations. Edit the $DPIPE_HOME/lib/trendtimer.sched file. To ensure that 
the satellite server completes hourly summarizations before the central server does the 
same, change the OVPI Timer start time from 1:00 to 1:00+20. By default, this process 
starts at beginning of every hour.

Configuring a Satellite Server

Follow these steps to configure a satellite server.

1 Switch off the following aggregations by commenting out the entries listed below, from the 
$DPIPE_HOME/lib/trendtimer.sched file:

24:00+03:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
daily_NNM_Event.pro

24:00+03:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
daily_NNM_Avail.pro

SU+24:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
weekly_NNM_Event.pro

MONTH1+24:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
monthly_NNM_Event.pro

MONTH1+24:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
monthly_NNM_Avail.pro

MONTH1+24:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
yearly_NNM_Avail.pro

2 Modify the hourly_NNM_Event.pro, by commenting out all entries except the following 
summarization:

{DPIPE_HOME}/bin/trend_sum -f {DPIPE_HOME}/scripts/hourly_NNM_Event.sum

3 Make sure that each satellite server is collecting data from a disjoint set of NNM stations.

System Clocks

Make sure that the system clock on each satellite server is synchronized with the system clock 
on the central server.

If you copy polled rate data from each satellite server every hour, you will 
increase the amount of traffic between the satellites and the central server 
and you will increase the processing load on the central server.
16



Chapter 4
Provisioning NNM Management Stations

This chapter covers the following topics: 

• Adding and Modifying Properties

— Using bulk import

— Using forms bundled with the NNM Event and Availability Report Pack

• Changing the HTTP Port Number of OVI on NNM

• Synchronizing Node or Category Information

• Changing the NNM Events Data Tool

• Checking Collection Failures

A list of NNM stations is required to collect event and availability data. There are two ways to 
produce this list: bulk import and OVPI forms.

Adding and Modifying Properties

Property information comes from the following sources:

• Forms bundled with the NNM Event and Availability Report Pack

• Common Property Tables batch-mode property import

• Common Property Tables (Device, Customer, Vendor)

• Category List Table

• NNM List Table

• NNM List Tables “add new” and “update” forms 

• Category List Table “add new” and “update” forms 

• Automatic feed from the network

If you have customers associated with specific devices or specific interfaces, or if you have 
vendors associated with specific devices, use Common Property Tables to import this 
information.
17



Adding and Modifying Properties
Bulk Import

To import a list of NNM stations using bulk import, perform these tasks:

• Task 1: Create the NNM station list file

• Task 2: Import the NNM station list file

• Task 3: OVPI data collection

Task 1:  Creating the NNM station list file

Create a property parameter file NNM_List.dat in the directory $DPIPE_HOME/data/
PropertyData/NNM_Event/ when bulk import of NNM stations is to be done or a set of 
NNM stations for collection is required. To import one NNM station, use forms as described in 
Using Forms on page 19

Format of the data is as follows:

<nnm_station_1><tab><ovi_port_number>

<nnm_station_n-1><tab><ovi_port_number>

<nnm_station_n><tab><ovi_port_number>

Example:

nnm1.hp.com  8092

nnm2.hp.com  8092

nnmn.hp.com  8092

The default OVI port number is 8092. 

Task 2: Import the NNM station list

To import the NNM station list, run the NNM List Importer tool

$DPIPE_HOME/bin/trend_proc -f $DPIPE_HOME/scripts/NNM_Event_import_nnm.pro

The tool imports the NNM_List.dat to the OVPI database. The imported list is now ready for 
data collection. 

Task 3: Data collection

Once the NNM stations list is provisioned, the system is ready for collection. During the first 
collection, the data collection tool will automatically:

1 Get the nodes from NNM with Device Type, Vendor, and Category information. 

2 Get data for the last two days from the NNM station or as available in NNM, whichever is 
lower. 

Change this port number only if you have changed the port number for the 
CommandResponder pluglet of OVI.

Errors are logged to: $DPIPE_HOME/log/trend.log 
18



Chapter 4
3 Put the category list into OVPI.

Using Forms

This section describes the following forms:

• Add or Update NNM List

• Remove NNM Station

• Add or Update Category Information

• Remove Alarm Category

• Update Availability Threshold

Use these forms to create, update or remove property data. 

To launch a form, click the Objects icon in the panel on the left side of the Management 
Console window. The Object/Property Management view opens. Object Manager shows a list 
of objects. The type of object presented depends on which Object Manager View is open. The 
default view is the Device view, showing a list of devices. To change the view, select View > 
Change View and use the pop-up window to select a different view. Once the type of object you 
are interested in updating is displayed, select the particular object you would like to update. 

When you select the object, Object Specific Tasks will appear in the window on the right. 
Double-click and open the form. Click Apply to save changes, OK to save changes and close the 
form, or Cancel to close the form without saving changes.

Add or Update NNM List 

Use the Add or Update NNM List form to add or modify the following:

• OVPI port number

• Polling interval

• Polling granularity

• HTTP timeout

Follow these steps to update an NNM station:

1 Launch the Management Console.

2 Click the Objects icon. The Add or Update NNM List form appears under General Tasks. 
Navigate to the NNM station you want to update, then double-click the Add or Update 
NNM list form.

3 Highlight the row that contains the data you want to change.

4 If required, change the Polling Granularity and then change the following entry in the 
$DPIPE_HOME/trendtimer.sched:

01:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/NNM_Event.pro

For example, if Polling Interval is 180 mins, then change the entry as shown below:  

03:00- - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/NNM_Event.pro

By default, data collection is done every hour. The data aggregated by NNM is 
at the periodicity (polling granularity) of 15 minutes.
19



Adding and Modifying Properties
Polling Granularity is the result of duration units divided by Polling Interval. For a given 
Polling Interval, events data collected can be aggregated over smaller units of duration 
(called Polling Granularity). For example, if Polling Interval is 60 mins, then Polling 
Granularity can have values such as 30, 60, and 180 mins.

5 Make the changes. Click Apply to save changes, OK to save changes and close the form, or 
Cancel to close the form without saving changes.

Follow these steps to add a new NNM station:

1 Select any row. 

2 Enter the name of the NNM station in the NNM Station field. Change other values as 
required.

3 Click Apply to save changes, OK to save changes and close the form, or Cancel to close the 
form without saving changes. 
20



Chapter 4
Remove NNM Station

Follow these steps to remove a single NNM station:

1 Launch the Management Console.

2 Open the Object/Property Management view. Select View > Change View and use the pop-
up window to select OV NNM view. The NNM stations are listed here. 

3 Select the NNM station you want to remove. 

4 Double-click the Remove NNM Station form under Object Specific Tasks. The form opens, 
showing NNM stations configured for OVPI data collection. 

5 Highlight the row that contains the NNM station that you want to remove. 

6 Click Apply to remove the NNM station, OK to save changes and close the form, or Cancel 
to close the form without saving changes.

Once you remove an NNM station, that NNM station will stop 
collecting data. Existing data is still available. 
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Adding and Modifying Properties
Add or Update Category Information

Follow these steps to update a new alarm category for an NNM station:

1 Launch the Management Console.

2 Click Objects. The Add or Update Category Information is listed under General Tasks. 
Double-click the form. 

3 Navigate to the NNM station and double-click the form. The form opens, showing category 
information. 

4 Highlight the row that contains the data you want to change. 

5 Make the changes. Click Apply to save changes, OK to save changes and close the form, or 
Cancel to close the form without saving changes. 

Follow these steps to add a new NNM station: 

1 Select any row. 

2 Enter the new Category Id and Category Name.

3 Click Apply to save changes, OK to save changes and close the form, or Cancel to close the 
form without saving changes.
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Chapter 4
Remove Alarm Category

Follow these steps to remove a category for an NNM station:

1 Launch the Management Console.

2 Open the Object/Property Management view. Select View > Change View and use the pop-
up window to select OV NNM view. The NNM stations are listed here. 

3 Select the NNM station that you want to remove. 

4 Double-click the Remove Alarm Category form under Object Specific Tasks. The form 
opens, showing NNM stations, Category Id, and Category Name.

5 Highlight the row you want to remove. 

6 Click Apply to remove a category for an NNM station, OK to save changes and close the 
form, or Cancel to close the form without saving changes.
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Adding and Modifying Properties
Update Availability Threshold

The Availability Threshold (percentage of availability) values are based on NNM station, 
Customer, Vendor and Device type. Threshold is the line between normal and abnormal 
performance. When this line is crossed, an exception is recorded. Thresholds are set to default 
values that are easily changed to reflect individual needs.

Follow these steps to change the threshold value:

1 Launch the Management Console (piadmin).

2 Click Objects., Under General Tasks you will see the Update Availability Threshold form. 
Double-click the form. The forms opens, showing the Availability Threshold table. 

3 Highlight the row that contains the Availability Threshold you want to change.

4 Make the changes. Click Apply to save changes, OK to save changes and close the form, or 
Cancel to close the form without saving changes.
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Chapter 4
Changing the HTTP Port Number of OVI on NNM

If the port number 8092 is already in use, do the following to change the port number:

1 On NNM, change the <serverPort>8092</serverPort> parameter in the file specified 
below to identify the new HTTP port number.

UNIX

$OV_INSTALL_DIR/conf/OVPI_INTEGRATION/ResponderProxyPluglet.config 

Windows

$OV_INSTALL_DIR/newconfig/OVPI_INTEGRATION/ResponderProxyPluglet.config

2 Re-start the OVI CommandResponder pluglet. To start or stop OVI, do as follows:

UNIX

$OV_BIN/ICO_ctl.ovpl -s : to stop OVI

$OV_BIN/ICO_ctl.ovpl -g : to start OVI

Windows

%OV_BIN%\ICO_ctl.ovpl -s : to stop OVI

%OV_BIN%\ICO_ctl.ovpl -g : to start OVI

Synchronizing Node or Category Information

Use the get_nnm_aggevt tool to synchronize the node information or category information 
from all NNM stations. 

• To update the NNM Event and Availability Report Pack with current node information 
from NNM, use the following script to get the node information:

$DPIPE_HOME/bin/perl $DPIPE_HOME/scripts/get_nnm_aggevt.pl -i

• If  you install new SPIs, the alarm category will change. To update the NNM Event and 
Availability Report Pack, use the following script to get node information:

  $DPIPE_HOME/bin/perl $DPIPE_HOME/scripts/get_nnm_aggevt.pl -c

Changing the NNM Events Data Tool

NNM uses the following tools to provide event data:

• ovdumpevents: This tool is the default data collection tool on OVPI. 

• ovdwquery: This tool is based on RDBMS. 

For more information about these tools, refer to the HP OpenView Network Node Manager 
Managing Your Network with HP OpenView Network Node Manager. 

Follow these steps to change the tool to ovdwquery:

1 Access the $DPIPE_HOME/lib directory

2 Create a configuration file named NNM_Event_Report.conf with the following entry:
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Checking Collection Failures
AGG_TOOL,ovdwquery

The new tool will be used in the next poll cycle.

Follow these steps to change the tool to ovdumpevents:

1 Access the $DPIPE_HOME/lib directory

2 Do one of the following:

• remove the conf file NNM_Event_Report.conf 

• modify the AGG_TOOL entry in the above configuration file as  
AGG_TOOL,ovdumpevents

Checking Collection Failures

Check the following log files in sequence:

1 On OVPI, the collection details for all NNM stations are logged in $DPIPE_HOME/log/
trend.log. Check for entries with get_nnm_aggevt.pl, the module that collects event 
data from NNM stations.

2 On NNM, collection details and failures, if any, are logged in

$OV_TMP/OVPI/NNM_EVT_RP_*log
26



Chapter 5
10 Sample Reports

This chapter provides samples of the following reports:

1 Detailed Availability Report

2 Availability Forecast by Customer

3 Availability SLA Report

4 Executive Summary by Vendor

5 Event Summary by NNM Station

6 Forecast by Severity

7 Hot Spots Top 20

8 NNM Events by Category and Device

9 NNM Events by Severity and Device

10 Executive Summary by Severity

Sample 1: Detailed Availability

Daily, monthly, and yearly availability information for a selected customer, and a selected type 
of device, on a per-vendor basis. This report does not show availability across multiple NNM 
stations. This report aggregates data at the NNM station level.

First select the NNM station, then select a vendor, a customer, and a device type. The table 
below the selection fields provides statistics for:

• Availability 

• MTTR 

• Total downtime

• MTBF

• Outage count

Use this report to see if availability for a particular device type managed by a particular NNM 
station is improving or worsening. 
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Sample 2: Availability Forecast by Customer

If multiple NNM stations are in use, this report aggregates data from all of them, and rolls up 
data to the customer level. Once you select a customer, you can either select All or a particular 
device type. The bar graph provides baseline, F30, F60, and F90 values for:

• MTBF

• MTTR

• Availability

• Downtime

Use this report to see whether the customer you selected is expected to see improved 
availability metrics or degraded availability metrics.

Sample 3: Availability SLA

The availability SLA report aggregates data for multiple NNM stations. It answers four 
questions:

• On average, is a particular vendor operating above or below the threshold for availability?

• Is a particular device type from one vendor operating above or below the threshold?

• On average, are the devices owned by a customer operating above or below the threshold?

• Is a device type owned by a particular customer operating above or below the threshold?

This report looks at downtime details as well as availability details. You can compare actual 
availability to the SLA value (the threshold for availability), and you can compare actual 
downtime to the SLA value (the threshold for downtime). 

Sample 4: Executive Summary by Vendor

This report aggregates alarm category and alarm severity data at the vendor level, on a 
station by station basis. Use this report to determine:

• The distribution of alarms across alarm categories

• Whether the number of alarms per category is increasing or decreasing

• The distribution of severity levels

• Whether the number of alarms per severity level is increasing or decreasing

Sample 5: Event Summary by NNM Station

This report aggregates the total number of events on a station by station basis. Use this 
report to find out what the total is for each NNM station and whether the total is increasing 
or decreasing.
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Chapter 5
Sample 6: Forecast by Severity

This report produces an alarm severity forecast. It aggregates severity data across all devices 
on a station by station basis, calculates a baseline value for each severity level, then lets you 
compare the baseline value to F30, F60, and F90. Use this report to find out which severity 
level was most prevalent over the baseline period and how each severity level is expected to 
behave in the future.

Sample 7: Hot Spots Top 20

This report aggregates events for each device on a station by station basis. Use this report to 
find out which devices are responsible for the most events. Select a station, then select a 
severity level. The graph below produces a list of devices, ranked by number of events, highest 
to lowest, allowing you to see event statistics for the twenty devices responsible for the 
majority of events.

Sample 8: NNM Events by Category and Device

This report aggregates event category statistics on a station by station basis. Use this report 
to drill down from an event category to a list of the devices responsible for the alarms in that 
category. The devices are ranked by the number of events in that alarm category, highest to 
lowest. Use this report to find out which devices are responsible for majority of events in each 
alarm category.

Sample 9: NNM Events by Severity and Device

This report aggregates severity level statistics on a station by station basis. Use this report to 
drill down from a severity level to a list of the devices responsible for the alarms in that level. 
The devices are ranked by number of events in that severity level, highest to lowest. Use this 
report to find out which devices are responsible for most of the events in each severity level.

Sample 10: Executive Summary by Severity

This report compiles data about the number of events per severity level. The results are 
available on a vendor-by-vendor basis and on a customer-by-customer basis. After selecting 
the NNM station, select a vendor and a severity level. The graph to the right shows the trend 
line for the number of events for this particular device and this particular severity level. You 
can also select a customer and a severity level. The graph to the right shows the trend line for 
the number of events for this particular customer and this particular severity level. Use this 
report to find out whether the event count for a severity level is increasing or decreasing.
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